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RL78/G24  

LED Lighting Control Application Model 

Introduction 

 This application note describes how to use the simulation model for LED lighting control system using the 
RL78/G24 microcontroller. This model simulates the LED lighting system control sample program 
[R01AN6673JJ0100] ("LED control program") and the RL78/G24 DC/DC LED control evaluation board 
[RTK7RLG240P00000BJ] ("LED control evaluation board"). 

 This model enables users to verify the control operation of LED lighting system using RL78/G24 
microcontroller on a PC. Users can efficiently develop LED control devices by examining control parameters 
in the preliminary stage of using actual devices. 

 This model simulates the operation of the microcontroller and software evaluation board. Please confirm the 
real operation with the actual device. 

 

Target Evaluation Kit / Sample Programs 

- LED control with RL78/G24 [R01AN6673JJ0100] 
- RL78/G24 DC/DC LED Control Evaluation Board [RTK7RLG240P00000BJ] 

 

operating environment 

OS Windows 11 (64bit) 
Windows 10 (version 20H2 or higher) (64bit) 

MATLAB Runtime R2022b 

 

 This model was created using MATLAB/Simulink and requires MATLAB Runtime to run. See chapter 4.2 for 
details. 
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1. Overview 

 This application note describes how to use the simulation model for LED lighting control system using the 
RL78/G24 microcontroller. This model simulates the LED lighting system control sample program 
[R01AN6673EJ0100] ("LED control program") and the RL78/G24 DC/DC LED control evaluation board 
[RTK7RLG240P00000BJ] ("LED control evaluation board"). 

 This model enables users to verify the control operation of LED lighting system using RL78/G24 on a PC. 
Users can efficiently develop LED control devices by examining control parameters in the preliminary stage 
of using actual devices. 

 This model simulates the operation of the microcontroller and software evaluation board. Please confirm the 
real operation with the actual device. 

 

2.  Related Documents 

(1)R01AN6673EJ0100 LED control with RL78/G24 

(2)R01UH0961EJ0100 RL78/G24 User’s Manual: Hardware 
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3. Simulation Model Operation 

 This model simulates LED lighting control system using the RL78/G24. The scope of simulation is the 
operations related to constant current and dimming control in the LED control program (see related 
document (1)). It does not simulate control instructions via the communication interface or the operation of 
functions related to the protection function when overcurrent (overvoltage) is detected. 

 Block diagram of the LED lighting control system simulation is shown in Figure 3.1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.1. Block diagram of LED lighting control system simulation 

 The functions of (1) through (3) in Figure 3.1 are as follows. 

(1) RL78/G24MCU Software Model 
  Model of software running on CPU 

     ・LED feedback (constant current control) 

   ・Dimming Control 

(2) RL78/G24MCU Hardware Model 
  Models of hardware (I/O functions) 

   ・PWM output by Timer KB0 

   ・AD conversion of LED current (voltage) using PGA and A/D converter 

(3) LED Circuit Model 
  Plant model to be controlled 

   ・LED control circuit (back converter circuit for constant current control) 

   ・LED (select one color as control target) 

 

 For details on each operation, refer to the LED control program (see related document (1)). 
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4. How to use simulation model

 This chapter describes the file structure and usage (installation, simulation setup, and run) of the model. 

4.1 File Structure 

 The model consists of the following files. 

File and folder structure 

./ 

│ RL78G24_LED_Simulator_setup.exe 
│ r20an0720ej0100-rl78g24-ledlightingcontrol-model.pdf 
└ readme.txt 

- Model installer
- Application Note (this file)
- Read Me file (please read first)

Installation folder structure 

./ 
└─Renesas_RL78G24_LED_Simulator/ 
  │ icon_48.png 
  ├─application 
  └─uninstall 

- Icon file
- Model exe file and data folder
- Uninstall folder

application folder structure 
Model exe file and data files are included. 

./ 
│Renesas_RL78G24_LED_Simulator.exe 
│ static_parameter_CPU.csv 
│ static_parameter_FAA.csv 
│ default_DiodeVI.csv 
│ 
│ default_InputVoltage.csv 
│ default_LEDlevel.csv 
│ 
│ readme.txt 
└ splash.png 

- IModel exe file
- Static parameter (CPU) setting example File
- Static parameter (FAA) setting example File
- Static parameter (Custom LED VI

characteristics ) template file
- Dynamic parameter (Input Voltage) template file
- Dynamic parameter (LED current level)

template file
- Read Me file
- Image File for exe file

4.2 Installation 

 To install the model, follow steps (1)-(2) . 

(1) Extract the contents of the file (r20an0720jj0100-rl78g24-ledlightingcontrol-model.zip) to any folder.

(2) Run the installer (RL78G24_LED_Simulator_setup.exe) and follow the instructions. 

 MATLAB Runtime (Version R2022b) is required to run this model. MATLAB Runtime is installed from the 
installer. 

 Windows security warnings may appear when running this model. Permission to communicate on the 
network is not required to run this model. 
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4.3 simulation 

Describes how to use simulations of the model. 

4.3.1 Operation steps and Screen structure 

To RUN the simulation, follow steps (1) - (4) . 

 (1) Run the program (Renesas_RL78G24_LED_Simulator.exe) 

 (2) Set simulation parameters (static and dynamic)   :See chapter 4.3.3 for details 

 (3) Start and Stop simulation      : See chapter 4.3.4 for details 

 (4) Check simulation results      : See chapter 4.3.5 for details 
 
Run the program and a window (Figure 4.1) will open. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.1. execution window 

 The functions of Figuer(a) - (e) are as follows  

(a) Menu 

  Control menu for this model     :See chapter 4.3.2 for details 

(b) Simulation parameters (static) 

  Input section for static simulation parameters   :See chapter 4.3.3 for details 

(c) Simulation parameters (dynamic) 

  Input section for dynamic simulation parameters   :See chapter 4.3.3 for details 

(d) Operation & Status Log 
  Displays operation history and simulation status 

(e) Simulation results 

  Waveform display of simulation results    :See chapter 4.3.5 for details 

(a) 

(b) 

(c) (d) 

(e) 
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4.3.2 Menu 

 Operations that can be controlled from the menu are shown in Table 4.1 

Table 4.1. Menu List 

Menu name Operation reference 
chapter 

File  Chapter 4.3.5 

 => Autosave If Check box is enabled 
Automatically saves simulation results to a file 

 => Save simulation result saves simulation results to a file 

Parameter  Chapter 4.3.3 

 => Load parameter Load each parameter from a file 

 => Save static parameter Save static parameters to a file 

Simulation  Chapter 4.3.4 

 => Run Start Simulation 

 => Stop Stop Simulation 

Help  － 

 => About View information about the model 
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4.3.3 Simulation parameters 

Simulation parameters are shown in Table 4.2 

Table 4.2. Parameter List 

Type Parameter name unit Setting range 
Min/Max 

Description 

Static L uH 0.0001/5000 L constants of LED circuits 

Static C1 uF 0.0001/1000 C constants of LED circuits 

Static C2 uF 0.0001/1000 C constants of LED circuits 

Static LED select - - LED color select for control 
(Red, Blue, Green, Custom) 

Static Custom LED VI 
characteristics 

V,A - 1-D Lookup Table of LED VI characteristics 
parameters when Custom is selected in LED 
select 

Static A1 - -500/500 PI control parameter A1 * 

Static A2 - -500/500 PI control parameter A2 * 

Static PGA offset - 0/4095 Offset voltage correction value of PGA * 

Static ADC vref V 0/10 Converted reference voltage of ADC 

Static Control cycle ms 0.001/1 Feedback period T * 

Static Simulation time ms 0.1/1000 Simulation end time 

Dynamic Input Voltage ms,V - Supply voltage of LED circuit 

Dynamic LED current level ms,- - Target current indication of PI control * 

* See the LED control program (see related document (1)) for details on the parameters. 
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(1) Static parameter 

 Static parameters are parameters that are fixed in value during simulation. 
 Examples: current value of constant current, LED control circuit constants. 

 Static parameters are indicated in Figure 4.1(b) on the GUI. 

 Static parameters can be saved and loaded as a file. 

  Save : Parameter => Save static parameter 
  Load : Parameter => Load parameter => Load static parameter 

 

 The static parameter file is saved in CSV file format. 

Note: Do not modify this file manually. 

 

 Static parameters have a defined setting range. If a value outside the range is set, the value is 
automatically changed. See Table 4.2 for the setting range. 

 Please use the CSV file attached to this model for setting values of static parameters in the LED control 
program (see related document (1)). 

 CSV File name (CPU) : static_parameter_CPU.csv 
 CSV File name (FAA) : static_parameter_FAA.csv 

 

 When Custom is selected for LED select, the LED VI characteristics parameters can be specified in the 
Custom LED VI characteristics field. The default values are the same as those entered for Red in LED 
select. 

 It is also possible to load pre-prepared parameters from the menu. 

 
   Load : Parameter => Load parameter => Custom LED VI characteristics 

 

 The parameter file is a 1-D Lookup Table of voltage V and current I expressed in CSV format. The values 
interpolated from this table are used as the VI characteristics of the LEDs. When editing, please use the 
CSV file attached to this model as a template. 

 Template file name(Custom LED VI characteristics)：default_DiodeVI.csv 

 Recommended specified values are 2 to 3 points near the current threshold voltage and at least 1 point 
near a voltage that is proportional. 
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(2) Dynamic parameter 

Dynamic parameters are parameters that give the control scenario a value that changes at specified 
times during the simulation. 

Example: input voltage, LED target current level 

Parameters can indicate values at specified timing (time) are shown in Figure 4.1(c) on the GUI. 
It is also possible to load parameters prepared in advance from the menu. 

 

  Input Voltage  ： Parameter => Load parameter => Input Voltage 

  LED current level： Parameter => Load parameter => LED current level 

 

The dynamic parameter file is a 1-D Lookup Table of time and indication values in CSV format. When 
editing, please use the CSV file attached to this model as a template. 

Template file name (Input Voltage)：default_InputVoltage.csv 

Template file name (LED current level)：default_LEDlevel.csv 
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4.3.4 Start and stop simulation 

Simulation can be started and stopped from the menu. 

Start : Simulation => Run 
Stop : Simulation => Stop 

 

The status of the simulation is shown in Figure 4.1(d) on the GUI. Parameter set values are displayed at the 
start, and progress is shown during running. 
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4.3.5 Simulation Results 

 When the simulation is completed, waveforms corresponding to the simulation results are displayed at the 
position shown in Figure 4.1(e) on the GUI. 

 Simulation result list is shown in Table 4.3. 
 

Table 4.3. Simulation Results List 

Name Unit Waveform Name Description 

LED current A LED 
current(blue) 

LED current 

LED level A LED  
current(red) 

LED current indication value (user specified) 

L current A L current L current 

Input Voltage V Input Voltage LED circuit power supply voltage (user specified) 

Duty - Duty Output PWM Duty 

ADC result - ADC result AD conversion value of current sensor voltage 

 

Simulation results can be saved as a CSV file. 
  Save : File => Save simulation result  

 

Simulation results can be saved automatically upon completion. 

 

 Auto save: select File => Autosave (check) 

 Do not auto save: select File => Autosave (no check) 

 

 The file name for the autosave file will be in the following format 

 File name: result_[YYYYYMMDDhhmmss].csv 

   Legend in [ ] ([ ] is not assigned to the file name) 

 YYYY : 4-digits 

 MM : 2-digit month 

 DD : 2-digit day 

 hh : 2-digit hour 

 mm : 2 digits of minute 

 ss : 2 digits of second 
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5. Revision History  

Rev. Date 

Description 

Page Summary 

1.00 2023.9.14 –  1st edition issued  
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Notice 

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 

product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use 

of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 

or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 

document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 

or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 

manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 

and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 

each Renesas Electronics product depends on the product’s quality grade, as indicated below. 

 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 

 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 

Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 

human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 

system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 

disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 

that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 

hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 

not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 

ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 

RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 

HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 

ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 

PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 

RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 

THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 

Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 

specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 

products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 

injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 

safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 

aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 

responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 

controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 

applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 

with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 

promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 

transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 

subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
 
   (Rev.5.0-1  October 2020) 

Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 

Koto-ku, Tokyo 135-0061, Japan 

www.renesas.com 

 For further information on a product, technology, the most up-to-date 

version of a document, or your nearest sales office, please visit: 

www.renesas.com/contact/. 

Trademarks   

Renesas and the Renesas logo are trademarks of Renesas Electronics 

Corporation. All trademarks and registered trademarks are the property 

of their respective owners. 
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